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Introduction 
 
The purpose of this training guide is to introduce you to Internet Native Banner (INB) and the 
basic functionality including names searches and navigation. 
 

Banner Product Suite (Modules) 
 

1. General 
2. Advancement 
3. Finance 
4. Financial Aid 
5. Human Resources – Payroll/Position Control 
6. Student 

 
Banner is an integrated database made up of six products listed above.  With Banner’s 
integrated database, all information is kept in one database and is accessed through the 
products.  This allows for consistent information and improved data integrity.  For example, if a 
Tennessee State University employee is also a TSU graduate, they would have one record in 
Banner, but activity in three modules: 
 

• Human Resources – Employment information 
• Advancement – Alumni information and activity 
• Student – Degree information 
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Accessing Banner 
 
If you do not have a shortcut on your desktop, Banner is available at the Tennessee State 
University web page at  www.tnstate.edu/banner. 
 

 
 
1. Go to www.tnstate.edu/banner 
2. Click the PROD System link 
3. The Logon page will open 
 

3  Updated – August 2014 
 

http://www.tnstate.edu/banner
http://www.tnstate.edu/banner


Banner – Basics/Navigation – Training Guide 

 
 

7. Enter your Username and Password* (database is not required) 
8. Click Connect 
9. Banner will open in a new browser 

 
*NOTE:  The first time you sign into Banner you will be prompted to change your 
password 
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The Main Menu 
 
The Main Menu contains links and fields that you will use to navigate through Banner. 
 

 
 

Parts of the Main Menu 
 

1. Menu Bar – Contains items that will be used to navigate and work through Banner 
2. Toolbar – A set of icons that represent shortcuts for performing common functions in 

Banner 
3. Title Bar – Displays the form descriptions, seven character code and other information 
4. Go To Field – Enter the seven-character code to open the form – be sure to press Enter 
5. Hierarchical Tree Menu Structure – Access forms through the main menu by selecting 

and opening folders 
6. Broadcast Messages Canvas – Displays messages that have been sent to all users 
7. Auto Hint/Status Line – Describes the field where the cursor is located also displays 

processing messages and errors 
8. My Links Canvas – Create up to six Personal Links for quick access to Banner forms or 

web pages 
 

1 

5 

4 

6 

7 

8 

3 
2 

5  Updated – August 2014 
 



Banner – Basics/Navigation – Training Guide 

Banner Naming Convention 
 
Every form in Banner has an abbreviated seven-character form name.  Most of the time, forms 
are referred to by this seven-character form name.  The position of the character and the 
character defines the form. 

Position 1 - Owner 
 
Identifies the Banner product owning the form. 
 

Code Product 
A Advancement 
F Finance 
G General 
N Position Control (Human Resources) 
P Payroll (Human Resources) 
R Financial Aid 
S Student 
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Position 2 – Sub-Module 
 
Identifies the application module (sub-module) owning the form.  It is also unique to the 
product identified in Position 1. 
 

Advancement (A) 
 

Code Purpose 
A Membership 
D Designation 
E Event Management 
F Campaign 
G Pledge and Gift/Pledge Payment 
L Label 
M Prospect Management 
O Organization 
P Constituent/Person 
S Solicitor Organization 
T Validation Form/Table 
U Utility 
X Expected Matching Gift 

 

Finance (F) 
 

Code Purpose 
A Accounts Payable 
B Budget Development 
C Cost Accounting 
E Electronic Data Interchange 
F Fixed Assets 
G General Ledger 
I Investment Management 
N Endowment Management 
O Operations 
P Purchasing/Procurement 
R Research Accounting 
S Stores Inventory 
T Validation Form/Table 
U Utility 
X Archive/Purge 
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Financial Aid (R) 
 

Code Purpose 
B Budgeting 
C Record Creation 
E Electronic Data Exchange 
F Funds Management 
H History and Transcripts 
J Student Employment 
L Logging 
N Need Analysis 
O Common Functions 
P Packaging and Disbursements 
R Requirements Tracking 
S Student System Shared Data 
T Validation Form/Table 
U Utility 

 
 

General (G) 
 

Code Purpose 
E Event Management 
J Job Submission 
L Letter Generation 
O Overall 
P Purge 
S Security 
T Validation Form/Table 
U Utility 
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HR/Payroll (P) and Position Control (N) 
 

Code Purpose 
A Application 
B Budget 
C COBRA 
D Benefit/Deductions 
E Employee 
H Time Reporting/History 
O Overall 
P General Person 
R Electronic Approvals 
S Security 
T Validation/Rule Table 
U Utility 
X Tax Administration 

 
 

Student 
 

Code Purpose 
A Admissions 
C Catalog 
E Support Services 
F Registration/Fee Assessment 
G General Student 
H Grades/Academic History 
I Faculty Load 
L Location Management 
O Overall 
P Person 
R Recruiting 
S Schedule 
T Validation Form/Table 
U Utility 
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Position 3 – Type of Form 
 
Identifies the type of form and the purpose of the form. 
 
 

Code Type of Form/Purpose 
A Application Form 
B Base Table 
I Inquiry 

M Maintenance 
P Process 
R Rule or repeating table (Report or Process) 
V Validation 

 
 

Positions 4 – 7 – Unique Identifier 
 
The last four characters of a form are a unique identifier.  There may be multiple forms that 
begin with the same three characters (ex:  SPAIDEN, SPATELE) the last four character help 
describe the form. 
 

Examples 
 

Code Purpose 
APAACTY Advancement - Activity Form 
FTVACCT Finance -  Account Code Validation Form 
RPAAPMT Financial Aid – Package Maintenance Form 
GUISRCH General – Search Form 
NBAJOBS Position Control (HR) – Employee Jobs Form 
PEAEMPL Payroll (HR) – Employee Information Form 
SGASTDN Student – General Student Form 
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Banner Forms 
 
Banner uses forms to enter and retrieve information from the database. 
 

How to Access Banner Forms 
 

From the Main Menu 
 

 
 

• Go To Field – Enter the seven-Character code and <Enter> 
• Personal Link – Click on the link you created  
• Hierarchical Tree Menu – Click through the product areas to expand and collapse the 

products and sub-modules 
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From a Form 
 
Both of the features are available from the File Menu Item. 

 

 
 

 
• Direct Access – The Go To Field will open in the Key Block 

 

 
 

• List of Forms Stored in File Menu – Banner remembers the last 10 forms accessed 
during the current session 
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Parts of Forms 
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1. Menu Bar – Provides a variety of ways to navigate, query, enter information and access 
Help functions 
 

2. Tool Bar – Contains icons used to navigate in Banner and provides other functions 
 

3. Title Bar – Displays the form’s descriptive name, the seven-character name and other 
information 
 

4. Key Block – Where you start on a form – enter the information of who/what you want 
to see 
 

5. Radio Button – Similar to a Check Box except only one choice can be enabled 
 

6. Date Field – Used to display dates for particular occasions 
 

7. Check Box – An indicator that can either be enabled (checked) or disabled (not checked) 
 

8. Pull-Down List – Used to select a value from a list of pre-defined values 
 

9. List of Values – A table of codes and descriptions that can be customized to meet the 
University’s standards 
 

10. Information Block – Data is displayed and/or entered in an Information Block 
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Menu Bar Components 
 

 
 

File Menu 
 

 
 
 

 

• Direct Access – Access a form without 
leaving the current form (Keystroke F5) 

• Object Search – Use to locate a form or 
other Banner object 

• QuickFlow – Displays the QuickFlow Form 
to access QuickFlows 

• Select – Enters the selected value into a 
field 

• Rollback – Returns you to the Key Block 
(Keystroke Shift-F7) 

• Save – Saves all changes entered since 
last save (Keystroke F10) 

• Refresh – Clears the message line 
• Print – Prints the current window 
• Exit – Exit form 
• Exit QuickFlow – Closes QuickFlow 
• Return to Menu – Takes you back to Main 

Menu 
• Preferences – Displays the Personal 

Preferences Maintenance Form 
(GUAUPRF) used to customize Banner 

 

Edit Menu 
 

 

• Cut – Cuts selected text (Keystroke Ctrl-X) 
• Copy – Copies selected text (Keystroke 

Ctrl C) 
• Paste – Pastes cut or copied text 

(Keystroke Ctrl-V) 
• Edit – Displays the editor window to enter 

and update text 
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Options Menu 
Note:  The Options Menu will vary from form to form.  It is typically used to take you to other 
blocks within the current form or to information in another form. 
 

 
 

Block Menu 
 

 

• Next – Moves cursor to the next Information Block – You 
must Next Block to leave the Key Block (Keystroke Ctrl-
Page Down) 

• Previous – Moves cursor to the previous Information 
Block (Keystroke Ctrl-Page Up) 

• Clear – Clears all information in current block to put 
Banner in Query Mode (Keystroke F7) 

 
 

Item Menu 

 

• Previous – Moves cursor to previous 
enterable field (Keystroke Shift-Tab) 

• Next – Moves cursor to the next enterable 
field (Keystroke Tab) 

• Clear – Clears, but does not delete from 
table, information from current field 

• Duplicate – Duplicates contents of same 
field in previous record and copies it into 
new record 
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Record Menu 
 

 

• Previous – Moves cursor to the first enterable field in the previous 
record (Keystroke Up Arrow) 

• Next – Moves cursor to the next record (Keystroke Down Arrow) 
• Scroll Up – Scrolls up the list of records, putting the first displayed 

record at the bottom of the list (Keystroke Page Down) 
• Clear – Clears all information from the display of the current 

record 
• Remove – Removes and permanently deletes if saved, all 

information for current record 
• Insert – Inserts a new blank record in the existing records 
• Duplicate – Duplicates content of all fields in a record and copies 

to a new record 
• Lock – Temporarily locks the contents of the record so no other 

Banner user can update  

Query Menu 

 

• Enter – Puts form into Query Mode 
(Keystroke F7) 

• Execute – Searches the dataset and display 
search results (Keystroke F8) 

• Last Criteria – Enters the criteria from your 
last search (must be in Query Mode) 
(Keystroke F7 twice) 

• Cancel – Cancels Query and takes form out 
of Query mode (Keystroke Ctrl-Q) 

• Count Hits – Counts the number of records 
that match search criteria – displays in Auto 
Hint line 

• Fetch Next Set – If more records meet the 
search criteria than fit in the window, select 
this option to display the next set of records 
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Tools Menu 
Use to access Banner Document Management and Workflows. 
 

 

Help Menu 

 

• Online Help – Displays online information 
for Banner forms and other objects 
(Keystroke Ctrl-H) 

• Dynamic Help Query – Displays the 
Dynamic Help Form (GUAHELP) in Query 
mode 

• Dynamic Help Edit – Displays the Dynamic 
Help form (GUAHELP) in Edit mode 

• Help (Item Properties) – Displays the 
Oracle item properties such as type of data 
and maximum length for the current field 

• Show Keys – Displays the list of functions 
and the equivalent keystroke 

• List – displays the Live of Values (LOV) for 
the current field if “List of Values” appears 
in the Auto Hint/Status Line (Keystroke 
Shft-F1)  

• Display Error – Displays code that is in 
error (if Oracle error) (Keystroke Shft-F1) 

• Display ID Image – Displays image 
associated with ID, if available 

• Calendar – Displays calendar 
• Calculator – Displays calculator 
• Extract Data with Key – Extracts Banner 

data from current block along with Key 
data for use in a spreadsheet 

• Extract Data No Key – Extracts banner 
data without Key data for use in a 
spreadsheet 

• About Banner – Displays the About Banner 
form (GUAABOT), which identifies current 
form, release number and other 
information  
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Toolbar Components 
 
The Toolbar is a set of icons that represent shortcuts for performing common functions. 
 

 
 

 Save (F10)  View/Send Message 

 Rollback (Shift-F7)  Print (Shift F8) 

 Select (Shift-F3)  BDM – Search 

Insert Record (F6)  BDM – Add Document 

 Remove Record (Shift-F6)  Workflow – Submit 

 Previous Record (Up Arrow)  Workflow – Release 

 Next Record (Down Arrow)  Broadcast Message 

 Previous Block (Ctrl-Page Up)  Fine Grain Access 

 Next Block (Ctrl-Page Down)  Multi-Institution (n/a) 

 Enter Query (F7)  Online Help 

 Execute Query (F8)  Supplemental Data Engine 

 Cancel Query (Ctrl-Q)  Exit 
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Name Searches 
 
There are multiple searches available in Banner.  
 

Single Match 
 When you perform a name search in Banner and a single match results, the name will 
automatically populate. 
 

 
 

1. Enter the Last Name, First Name <Enter> 
 

 
 

2. Results display 
a. Next Block to move through the form 
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Wildcard Search 
 
Use the Wildcard (%) when there are different ways to spell a name.  In this example, we will be 
looking for Kristine Hanson.  Kristine can be spelled multiple ways, including Christine.  Using 
the Wildcard (%) will include the different variations. 
 
 
 

 
 

1. Enter the last name (hanson), enter the first name using the Wildcard (%ristine) <Enter> 
 

 
 

2. Results display 
a. Next Block to move through the form 
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Name Search with Multiple Results (Reducing your Results) 
 
When multiple results match your search, the ID and Name Extended Search Form will open.   
 

 
 

1. Enter the name search (last name, first name <Enter>) 
2. The ID and Name Extended Search window will open 
3. Enter the criteria to reduce your search 

4. Click the Narrow Search Results Icon  
a. Results will narrow 

i. Note the Person/Non-Person Count 
5. Click the pull-down list to display results 
6. Select the name 
7. Selected name will populate in Key Block 

a. Next Block through the form 
 
 
 
 
Tennessee State University is an AA/EEO employer and does not discriminate on the basis of race, 
color, national origin, sex, disability or age in its program and activities. The following person has 
been designated to handle inquiries regarding the non-discrimination policies: Ms. Tiffany Baker-Cox, 
director of Equal Opportunity and Affirmative Action, 3500 John A. Merritt Boulevard, Nashville, TN 
37209, (615) 963-7435. 
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